
Introduction 
 
Welcome to Blazer for Windows, the program that processes and generates Blumberg forms on plain paper, 
using your personal computer and any Windows 95/98 supported printer.  Blazer for Windows was designed 
and operates in the Microsoft Windows 95/98 environment, making data entry simple and straight forward. 
 
Blazer for Windows has the following unique advantages: 
 
• Easy to install and use 
• Windows environment makes data entry easy 
• Graphic forms generated on plain paper 
• Automatic math calculations 
• On line help 
 
 

System Requirements 
 
Blazer for Windows is designed to work on the IBM PC 486 and Pentium (or compatible) computers, with a 
minimum of 16 MB RAM, hard drive with at least 20 MB space available, Windows 95/98 and a mouse. 
 
Any Windows 95/98 supported printer can be used with Blazer for Windows. 
 
Note!  This instruction manual explains how to use the Blazer for Windows software program only.  Please 
refer to the Microsoft Windows software documentation for instructions on how to use Windows and the 
user manuals for your computer, mouse and printer for instructions on use or your hardware. 
 
 

New and Revised forms 
 
New and revised forms are available free on our internet site at http://www.blumberg.com.  Call 
212-431-5000 x 565 to pick up new files.  Watch our advertisements in the New York Law Journal and no-
tices with your monthly statements for information about new and revised forms for Blazer.  Registered licen-
sees will be sent notices about Blazer periodically. 
 

Registration 
 
Please call North Winds at 724-838-8993 to register your Blazer Program.  Registration of the program 
enables us to keep you advised of changes in forms as well as provide updates and improvements of the 
Blazer program.  Registration acknowledges you acceptance of the terms of the Blazer license. 

 
Without registration., the Blazer program will print 10 draft pages.  When you register, 
you will be assigned a Program Number.  1000 additional counts will be added to the 
counter when you enter the Program Number into the system. 
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Copyright Notice 
 
This software package and document are copyrighted under the Copyright Law of the United states by Blum-
bergExcelsior, Inc.. All rights are reserved worldwide.  No part of this software and publication may be repro-
duced, transmitted, transcribed, stored in any retrieval system, or translated into any language by any means 
without the express written permission of BlumbergExcelsior, Inc., 62 White Street, New York, NY 10013, 
with the following single exception.  You may make archival copies of the software for the sole purpose of 
backing up the software and protecting your investment from loss. 
 
 

License Agreement 
 

The price paid for a single copy of Blazer licenses you to use the product on one CPU.  
The license allows the license owner to move the software from one computer location to another, so long as 
there is no possibility of its being used at one location while it is being used at another. 
 
The price paid for a Blazer 5-user network entitles you to use the product on a network server or a peer to peer 
network with no more than 5 computers or a peer to peer network with no more than 5 stations. 
 
The price paid for an unlimited site license entitles you to use the product at all individual stations at one 
site, on all stations of a peer to peer network at one site, and on all network servers at one site. 
 
 
Disclaimer 
 
North winds and BlumbergExcelsior, Inc. make no warranties as to Blazer software or the contents of this 
documentation and disclaim any implied warranties of merchantablility or fitness for any particular purpose.  
Norht winds and BlumbergExcelsior, Inc.  Further reserve the right to alter the specifications of the program 
and/or the contents of the manual without obligation to notify any person or organization of these changes. 
 
 
Our law forms have important legal consequences and should be prepared and should be prepared and 
executed under the supervision of an attorney.  It is the ultimate responsibility of the attorney to deter-
mine their legal sufficiency for the use intended, with or without change.  Liability will not be accepted for 
any loss or damage however caused or by whomever used. 
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Program Installation 

Blazer 2.0 Beta Installation Instructions: 
 
1. Run File setup.exe found on the CD. 
2. Hit <Next> 
3. Select directory for the Blazer program (we recommend to keep the  
   default setting 'C:\Blazer2', Click <Next> 
4. Adobe Setup starts, Click <Next> 
5. Click <Yes> to the License Agreement 
6. Select directory for the Adobe program (we recommend to keep the  
   default setting 'C:\Adobe3\Exchange\', if this directory is not selected, the program will not run right.  
You'll need to call Tech Support at (724) 838-8993 to correct this problem if not installed properly), Click 
<Next> 
7. Click <Yes> 
8. Click <Next> 
9. Click <Finish> 
10. Click <Ok> 
11. Click <Finish> 
 
NOTE:  If the Blazer 2.0 setup detects an existing Adobe program  
       already running on your machine, it will skip steps 4  
       through 10. 
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Quick Start 

This is the first step to take when you execute the program for the very first time.  The database, in terms of 
this program, is symbolic with directory, e.g., database HENRY is nothing more than a directory named 
HENRY.  It could resemble the name of the attorney or a special group.  Each attorney in a law firm can have 
his/her own database. 

Adding a Database 

Select a directory UNDER which you would like to create a database by double-clicking on the parent direc-
tory.  Then choose the “Add” button.  A dialog box will appear requesting a name for the database that is 8 
characters or less and no spaces.  Type in the name and choose the “OK” button (or the “Cancel” button  to 
abort the operation).  This will create the database under the currently highlighted directory. 

Adding a Matter 

After you have created a database and it is the current directory on the left hand side of the screen, you are 
now ready to add a matter.  Just click on the "Add" button on the right hand side of the screen.  A dialog box 
will appear requesting the name of the matter that is 40 characters or less.  Type in a name and choose the 
"OK" button or the "Cancel" button to abort the operation. 

When You first start the Blazer program the 
screen to the right will appear.  Before you can 
access the Blazer Forms, you must first create a 
database directory and a matter.  Follow the 
instructions on this page for adding a database 
and matter. 

Once you have successfully created a database and have added a matter to the database, The OK Button lo-
cated at the bottom of the Open Matter screen will be enabled and have a green check mark.  Clicking on this 
OK button will bring up the list of forms.  Select the form type you need and simply highlight the form you 
wish to process and choose the "View Currently Selected Form" button.  The form will be displayed graphi-
cally, exactly the way it prints, and entry fields will be laid out over top of the form. 
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Database/Matter 
This is the Most important screen in the entire 
system.  You cannot access anything else except 
“Utilities” until you enter this screen and select 
or create a valid Blazer database and select or 
create a matter. 
 
From this screen add databases and select/
rename/delete/add matter. 
 
This screen will come up automatically when 
the program is first executed.  To get to this 
screen, choose FILE|OPEN from the menu on the 

This is the first step to take when you execute the program for the very first time.  The database, in terms of 
this program, is symbolic with directory, e.g., database HENRY is nothing more than a directory folder 
named HENRY.  It could resemble the name of the attorney or a special group.  Each attorney in a law firm 
can have his/her own database. 

 
When you run the program for the very first time, the directory “BLAZER2” will be the current directory.  
That is, if you selected the default application directory during installation.  You can either choose the “Add” 
button here to create a new database under “BLAZER2” or choose another location.  This is the first step to 
take when you execute the program for the very first time.  The database, in terms of this program, is symbolic 
with directory, e.g., database HENRY is nothing more than a directory named HENRY.  It could resemble the 
name or the attorney or a special group.  Each attorney in a law firm can have his/her own database 
 
 
Select a directory UNDER which you would like to create a database by double-clicking on the parent direc-
tory.  Then choose the “Add” button.  A dialog box will appear requesting a name for the database that is 8 
characters or less and no spaces.  Type in the name and choose the “OK” button (or the “Cancel” button  to 
abort the operation).  This will create the database under the currently highlighted directory. 
 
Creating a new directory will add "DEFAULT INFORMATION" to the Matter.  For more information on using 
the default information, see "Default Information". 
 

 
 

Adding a Database 
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Note:  This will remove ALL data associated with the matter(s) listed in the right had box labeled “Matter”. 
 
Select the database/directory in the box on the left hand side labeled “Database (directory)” that you wish to 
delete.  Make sure to double-click the folder to make sure it is selected.  Click on the “Delete” button on the 
left hand side of the screen.  A message will appear requesting confirmation.  You can either choose “Yes” or 
“No”. 

Deleting a Database 



Database/Matter (Cont.) 
Copying a Database 

This option allows you to backup all the matter 
information residing in a database to another loca-
tion. 
 
Select the database / directory in the box on the left 
hand side labeled "Database (directory)" that you 
wish to copy. A destination dialog box will appear 
listing a directory tree and a drives box.  Select a 
drive (floppy, local hard drive or a network drive) 
from the drives box.  Select a directory on the se-
lected drive that you wish to copy the database 
files to.  Choose the "OK" button or the "Cancel" 
button to abort the operation. 
 

Adding a Matter 

After you have created a database and it is the current directory on the left hand side of the screen, you are 
now ready to add a matter.  Just click on the "Add" button on the right hand side of the screen.  A dialog box 
will appear requesting the name of the matter that is 40 characters or less.  Type in a name and choose the 
"OK" button or the "Cancel" button to abort the operation. 

Deleting a Matter 
Click to highlight a matter name that you wish to delete and click on the "Delete" button.  A message will 
appear requesting confirmation.  You can either choose "Yes" or "No". 
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original  database.  To add matters to a database, use the copy under the matter section 

Default Information 
 
Whenever you add a database it automatically puts a Default Information into the Matter.  You can use DE-
FAULT INFORMATION to create master documents with fields filled in that you can add to any Matter that 
you create.  When you add a Matter to a Database, you will be asked if you would like to add the default in-
formation.  If you select "Yes", any information that is on any of the forms in the DEFAULT INFORMATION 
Matter will be added to your new Matter. 



Database/Matter (Cont.) 

Renaming a Matter 

Click to highlight a matter name that you wish to rename and click on the "Rename" button.  A dialog box 
will appear requesting the new name of the matter that is 40 characters or less.  Type in the name and choose 
the "OK" button or the "Cancel" button to abort the operation.  All the information that was under the old 
name will now be under the new name you choose. 

Selecting a Matter 
Click to highlight a matter name that you wish to select and click on the "OK" button located at the bottom 
of the screen. 
 
This database and matter will now be the active database and matter in the system.  After choosing the "OK" 
button to return to the main screen, a list of available forms will appear from which you can process. 
 
Note:  Whenever you exit Blazer,  the program will recall the current database and matter the next time the 
program is executed. 
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Copy a Matter 
 
This option allows you to copy all of the information from one matter to another Blazer 2.0 database. 
 
Click to highlight a matter name that you wish to copy and click on the "Copy" button.  A destination dialog 
box will appear listing a directory tree and a drives box.  When you are copying a matter, it can only be cop-
ied to another Blazer 2.0 database and the matter name cannot already exist in the destination database. 
When you have the destination database folder selected click on the "OK" button to copy the matter into the 
database folder 



Manipulating Data 
After you have created a database and selected a matter, you now have access to many forms. 
 
On the main screen, the list of forms will appear.  Simply highlight the form you wish to process and choose 
the "View Currently Selected Form" button.  The form will be displayed graphically, exactly the way it prints, 
and entry fields will be laid out over top of the form. 

Multiple Page Legal Documents 

You can distinguish among a single page and multiple page legal 
document by seeing if the "Next Page" option under the "Options" 
menu is available.  This also indicates that this current page is the first 
page of a multiple page legal document.  To view the next page, simply 
select this option.  To view the previous page, select the "Previous 
Page" option under the "Options" menu. 

You can distinguish which page is the last by seeing if the "Next Page" option is NOT available whereas the 
"Previous Page" option is available. 
 
A single page legal document will disable both of these options. 
 
NOTE:  If you use the scroll bars to go to each page, the Menu options "Next Page" and "Previous Page" 
might not work properly. 

Entering Field Data 

To activate a field on the screen, you must use the mouse to click on the form where a field resides.  The cur-
sor will appear on the form and the field color will change to white, which means you are now able to type 
data into the form.  Hitting <TAB> will move you to the next field. 
 
Note:  When saving the form make sure to click out of any fields that you are entering data into.  If a field is 
active during the save, then the information in the field will not be saved. 

Resetting the Field Data 

You can clear all the data in the fields by going to menu item "File" -> "Reset Data". 
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Printing Forms 
Printing forms is all based on the counter.  A minimum of 1 count 
is deducted for printing a "draft" copy of a single page of a legal 
document and a minimum of 2 counts for printing a "final" copy 
of a single page of a legal document.  For example, if you print a 
final copy of the "Residential contract of sale" for matter JOHN 
DOE that contains 4 pages, 8 counts will be deducted from the 
total. 
 
To print a legal document, select "Draft" or "Final" from "Print" 
under the "File" menu.  This will bring up a dialog box indicating 
the print range.  Choose all pages or selected pages, and the  

number of copies, and whether you want "Double-Sided" or "Single-Sided" printing..  Click "OK"  to continue 
to print or "Cancel" to stop the printing process. 
 
Note:  The selected pages option is ONLY available for multiple page forms.  For single page forms, this dia-
log will not appear, prior to printing. 
 
When you click "OK" to continue to print, a wait box appears displaying the number of counts used of the 
total counts available.   

Single_Sided and Double-Sided Printing 
You have the option of printing multiple-page forms "Single-Sided", or "Double-Sided".  if you select 
"Single-Sided", the form will print on one side of the page.  If you select "Double-Sided", after printing the 
front side of each page, you will be prompted to feed the form back into the printer, as to allow printing on the 
opposite side. 

Printer Setup 
To change printers choose Menu item 
FILE -> PRINTER SETUP before print-
ing the document.  A Printer Dialog box 
appears, allowing you to select printers. 

Letter Size vs. Legal Size Printing 
Each document is designed to be either printed on Letter Size Paper (8.5" X 11"), or  Legal Size Paper (8.5" X 
14").  Forms with an asterisk (*) before the title on the List of Forms screen or at the top of the screen while 
you are in the form must be printed on Legal Size Paper. 
 
To change the Paper Size setting while in a document, go to the menu item FILE -> PRINTER SETUP Click 
on "Printer Settings" in the Printer Dialog box that appears. 
 
NOTE:  By changing the Printer Setup, or the Printer Settings, you are adjusting the default Printer Settings 
on your computer. 
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Utilities 
In the Utilities Section you can  manipulate the log file, convert databases from Blazer 1.0, verify the integ-
rity of your data and repair corrupted data. 
 
Click on the appropriate tab at the top of the screen or pull down the "Options" menu and select one of the 
four selections. 

Note:  The log file records important information each time you print or use counts.  It records the date, time, 
matter name, form name and the counts used.  The primary purpose of the log file is to maintain accurate bill-
ing records. 

Counts Log 
You can modify the text directly, filter data using specified criteria (criterion), sort using specified criteria 
(criterion), change the location of the log file, build a text file and clear the contents of the log file. 
 
Modify the Text Directly in the Log File 
 
Locate the text to be modified in the table, double-click or press F2 to get a flashing cursor, then just make 
the appropriate changes. 
 
To add a line to the log file, highlight in the table to the place of insertion and press "Insert".  A blank l ine 
will appear above the line highlighted. 
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Utilities (Cont.) 
To delete a line from the log file, move the highlight in the table on the screen to the place of deletion and 
press "Ctrl+Del".  A message appears requesting confirmation to delete, select "OK" or "Cancel". 
 
Filter On Specified Criteria (Criterion) 
 
Type in either a matter name or a form name or both in the edit boxes located in the group box labeled 
"Filter".  To filter information, click on "Filter".  To remove the filter, click "Remove Filter". 
 
The filtering  results will appear in the table.  If you build a text file, which is discussed below, it will take the 
information that is in the table and write a text file.  For example, if you type in JOHN DOE for the matter 
name in the filter edit box then clicked "Build Text File", the data that gets written to the text file will NOT 
be filtered on matter name JOHN DOE.  You must first click on the "Filter" button prior to building the text 
file. 
 
Change the Location of the Log File 
 
The log file "LOG.DB" can reside on any machine in any directory that you choose.  If, there are many work-
stations in a network, use this utility to make all workstations write to ONE log file.  Even if you have the pro-
gram installed on each workstation, you can still share the same log file.  Keeping track of all activity using 
this program can be in one place.  If you want each workstation to have its own log file, use this utility. 
 
The current location of the log file can be found in parenthesis on the right side of the text "Counts Log" at 
the top of the screen. 
 
To change the location, click "Location" at the bottom of the screen.  A dialog box appears with a directory 
tree and a files box.  Select the directory that contains the log file  you want.  The file name "LOG.DB" should 
appear in the list box under file name. 
 
Note:  The log file must exist in the directory choosen in the dialog box. 
 
Highlight the name and choose "OK".  The path that appears in parenthesis will change to the new location's 
directory path.  The table on the screen will reflect all the data that is in the log file in the new directory. 
 
Note:  When there is no data in the log file, the ONLY option available is "Location".  All others will not be 
accessible. 
 
Build a Text File 
 
you can write the filtered / sorted information from the log file to a text file.  Use the text file to import into a 
word processor or spreadsheet, to build reports. 
 
To build a text file, click "Build Text File" at the bottom of the screen.  A dialog box appears with a directory 
tree and files box.  Select the directory you want.  Type in the file name in the files box or select an existing 
file to overwrite.  Choose "OK" to continue to build the file.  After the process is complete, the file will be dis-
played on the screen. 
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Utilities (Cont.) 
An example of the format of the file that is generated using this utility: 
        DATE AND TIME = 10/22/96 3:10:00 PM 
        MATTER NAME = JOHN DOE 
        FORM NAME = New York Litigation Back 
        COUNTS SPENT = 6 
 
        DATE AND TIME = 10/22/96 3:15:30 PM 
        MATTER NAME = JOHN DOE 
        FORM NAME = Subpoena Duces Tecum 
        COUNTS SPENT = 2 
 
        ............. 
        ............. 
 
 
Clear the Contents of the Log File 
 
You can empty all the data out of the log file.  Click on "Clear Log" at the bottom of the screen.  A message 
will appear asking for confirmation, choose "Yes" or "No".  After the process is complete,  the ONLY option 
that remains available is "Location". 
 
 

Convert Database 
 
Transfer Blazer 1.0 databases to Blazer 2.0 with the "Convert Database" option.  Select the directory where 
the old database resides, and "Convert Database".  If this does work, the existing database from Blazer 1.0 was 
found in that directory. 
 
 

Verify / Repair Database 
 
This utility should only be used if you are finding strange things happening with the data.  If you enter infor-
mation, save it, go back into the form and it is not there,  there may be corruption. 
 
To repair data, choose the directory that contains your data, then select "Verify Database".  The program will 
verify the integrity of each bit of information.  If a problem is found, a prompt will appear requesting authori-
zation to repair.  Choose "OK" or "Cancel". 
 
Note:  It is best to contact technical support before using this utility. 
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Counter 
The counter  tracks the number of forms you print.  You are charged 1 count per "draft" copy per single page 
and 2 counts per "final" copy per single page. 
 
Note:  Blazer for Windows, comes with 10 free counts to enable you to evaluate the program.  1000 counts  
are included with the purchase.  To acquire the 1000 counts, register the product by calling 724-838-8993.  
After registration and receipt of these initial counts, the program can not be returned. 

the counter is controlled with the counter functions screen.  To get to 
this screen, go to the main screen or the screen that contains the list of 
forms.  Select "Counter Functions" under the "File" menu. 
 
Note:  Most of the activity performed with the counter is handled by 
technical support. 

This screen serves the following purposes: 
 
• Provides the number of used counts  
 
• Add to the total number of available counts 
 
• Move the counter from one computer to another 
 
• Remove the counter 
 
 

Adding Counts 
 
Counts are added in increments of 500, 1,200, 2,400, 3,600, and 4,300.  Bring up this screen when you call 
technical support to add counts. 
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Counter (Cont.) 
You must provide the code number and the computer number.  Technical support will give you a code num-
ber to enter in the edit box labeled "Given Code Number".  Choose the "OK" button to complete the proce-
dure 
 

Moving the Counter from One Computer to Another 
 
When you execute the program for the very first time, the counter is created for your specific machine.  In case 
you replace your computer or wish to install Blazer to a network you may have to move the counter. 
 
Move the counter from drive C: (hard drive) to drive F: (server).  To move the counter from one drive to an-
other, drop down the box labeled "Location of Counter" and select the drive that you wish to move the coun-
ter to.  Provide the code number and computer number to technical support.  Enter in the code number pro-
vided by technical support in the box labeled "Given Code Number".  Choose the "OK" button to complete 
the move.  if a counter already exists on the server, the remaining counts in the counter on your hard drive 
will be added onto the counter on the server.  For example, if drive C: has a counter of 6 of 10 and the server 
has a counter of 10 of 500, then the result of the move would be a counter on the server of 10 of 504. 
 
Note:  You can't move the counter to a floppy drive.  This is restricted by the program. 
 
 

Removing the Counter 
 
You may want to remove the counter if you replace your computer, if the program is having difficulty com-
municating with the counter or in the event of a system crash. 
 
Following the same procedures, you must provide the code number and computer number to technical sup-
port.  Enter in the code number provided by technical support in the box labeled "Given Code Number".  
Choose "OK"  to complete the procedure. 
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Network Configuration 
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Note:  The procedures below should be handled only by  a network administrator. 
 
Blazer for Windows can be installed on each workstation hard drive or on the server.  To share data among 
workstations and the server, the steps described below must be followed: 
 

Step 1 – Files to be Copied 
 
• Blazer for Windows installed on each workstation. 
 
In this case, there are no files that need to be copied from the server to the workstation.  Follow Step 2, below. 
 
• Blazer for Windows installed on the server only. 
 
all files in the C:\Program Files\Borland\Common Files\BDE directory on the file server must be copied to 
each workstation that will use the program.  These files can be placed in any directory on the workstation.  It 
does not have to be the same used on the file server. 
 
Note:  To simplify finding these files, copy the C:\Program Files\Borland\Common Files\BDE directory and 
place it on the C:/ drive of the workstation. 
 

Step 2 – Settings to be Modified 
 
• Configuring the File Server 
 
From any workstation or the fi le server itself, execute the BDE Administrator program.  From the server, where 
the program was installed, there will be an icon in the Start | Programs | Blumberg for the BDE Administrator.  
The file is located in the C:\Program Files\Borland\Common Files\BDE directory named bdeadmin.exe. 



Network Configuration (Cont.) 
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When the BDE Administrator starts,  under configuration select drivers, under drivers select native, then un-
der Native select PARADOX.   On the right side of the screen, under Definition, the first line should read NET 
DIR with a directory path across from it.  This path should be the C:\Program Files\Borland\Common Files
\BDE.  This is set to “C” because the file server looks at itself as “C” and this NET DIR path needs to point to 
the directory with the PDOXUSRS.NET file.  After you have the NET DIR directory properly set, go to Object 
on the menu then exit.  If you made any changes to the directory path, you will get a warning message that 
reads “Save all edits to BDE Administrator C:\Program Files\Borland\Common Files\BDE\IDAPI.CFG?  To 
save the changes say “Yes“. 
 
• Configuring the Workstation 
 
From each workstation that will be sharing data, execute the BDE Administrator.  If Blazer is installed on the 
workstation, there will be an icon for BDE Administrator in Start | Programs | Blumberg.  If Blazer is installed 
on the server only, you can execute the file from the BDE directory that you copied from the server.  The file 
name is bdeadmin.exe. 

When the BDE Administrator starts,  under configuration select drivers, under drivers select native, then un-
der Native select PARADOX.   On the right side of the screen, under Definition, the first line should read NET 
DIR with a directory path across from it.  This path should point to the “Program Files\Borland\Common Files
\BDE” Path that is on the Server.  In the example above, the server drive letter is “R”.   
 
Note:  All workstations and the server need to point to the same directory where the PDOXUSRS.NET file is 
located on the server (“Program Files\Borland\Common Files\BDE”).  This is what enables the computers to 
access the database simultaneously. 
 
If Blazer is not installed on the workstations, the only remaining task is creating desktop Icons on the work-
stations for accessing the program. 



Adobe 
Blazer 2.0 uses a 3rd party software utility from Adobe that enhances the programs performance.  When a 
document is opened, Blazer 2.0 uses the Adobe utility to display the file.  During installation, Blazer 2.0 
searches the computer to see if a copy of the Adobe utility (Exchange, 4.0) already exists on the computer.  
For Blazer 2.0 to work properly, Adobe Exchange must not be running on the computer.  If errors occur dur-
ing the opening of a document, close all programs and reboot the computer.  If errors still occur, press CTRL-
ALT-DEL to check that Adobe is not running (could be listed as "Adobe Exchange, "AcroEx32", or "Adobe 
Acrobat").  If it is, select it and press "End Task", then run Blazer 2.0   
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Technical Support 
We know that you will find Blazer for Windows productive and easy to use. However, if you have a problem 
and need assistance, please contact North Winds, Inc. at the numbers below for technical support during East 
Coast business hours (8:00 a.m. to 4:30 p.m.). If you have a question about the forms call Blumberg/
Excelsior's customer service representative at (212) 431-5000. We will be happy to help you. 

Voice: (724) 838-8993 
 
Fax: (724) 832-8598 
 
Email: support@nwinds.com 
 
Web Site: www.nwinds.com 
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